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1Touchpad MODULAR Ver. 4.0-VII (Answer Key)

	   Types of Software

Exercise
A.	 1. d.	 2. d.	 3. b.	 4. d.	 5. b.
B.	 1. Operating System	 2. Virus scanner	 3. Application software
	 4. Spreadsheet		  5. DTP
C.	 1. F	 2. T	 3. F	 4. F
D.	 1. �Data Compression Program is used to compress a large file into a file of smaller size so that 

it occupies less space and is easy to store. Winzip and Winrar are examples of these software.
	 2. �A Language Processor is a type of software that translates human-readable programming 

code into machine-readable instructions that a computer can execute.
	 	 Example: Assembler, Compiler and Interpreter
	 3. CUI stands for Character User Interface.

E.	 1. �The memory of a computer is divided into small blocks. The files are stored in continuous 
blocks of space in the hard disk. When a file is deleted from the computer, a part of that 
space becomes free. When a new file is saved on the computer, some part of it is saved on 
the first available free space in the memory. After some time, the files get stored in various 
fragments which slows down the speed of the computer. The Disk defragmenter organises 
the fragments of files into continuous blocks to improve performance of the computer.

	 2. �General purpose software are those which have not been developed according to the needs 
of a particular organisation or a particular industry. It can be used for both commercial and 
non-commercial purposes. Example: Word Processors, Spreadsheet Software, Presentation 
Graphics Software, Graphics software, DBMS software, Multimedia and DTP software .

	 3. �System Software is the most important software to operate a computer. It manages a 
computer’s hardware and basic functions. For eg -  operating system, language processor.

		�  Application Software is a program designed to help users perform specific tasks. It is designed 
to be used by end-users. Generally, people refer to application software as software For 
eg – General purpose software, customised software.

1.
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F.	 1. Manav can use Desktop Publishing Software like Corel Draw and Adobe Photoshop.
	 2. �Roshni can explain hardware as the physical components of computer system that she can 

touch and see while software as another term used for a computer program which controls 
the computer system and make it do useful work. She can compare hardware to a TV and 
remote, while software is like the channels and programs running on it.

	   Advanced Features of Windows 10

Exercise
A.	 1. a.	 2. c.	 3. b.	 4. b.	 5. b.
B.	 1. File explorer	 2. CPU	 3. Date	 4. Font	 5. Delete
C.	 1. F	 2. T	 3. F	 4. T	 5. F
D.	 1. �Wildcard is a special character which is used to represent one or more characters. Generally, 

two wildcard characters are commonly used for searching files in a system. These are asterisk(*) 
and question mark (?).

	 2. �Extra Large Icons View and Small Icons View are the two different views provided by Windows 
in which we can view our files and folders.

	 3. Ease of Access is used to adjust your computer setting for vision, hearing and mobility.
E.	 1.	The steps are:
	 	 Step 1: �Open the Control Panel window and click on the Appearance and Personalization 

category.
	 	 Step 2: Click on the Fonts subcategory.
	 	 Step 3: Open the folder containing new fonts which you want to add.
	 	 Step 4: Drag the desired font and drop it into the Fonts window.
	 2. �Question mark replaces a single character or symbol. It represents only one character so it 

searches for only one character. For example, when we type C?M in the search box of the File 
Explorer then it will display only files or folders whose names begin with three characters in 
which first and third characters are C and M.

	 3. Some important computer settings and their uses are: 
	 	 • �System and Security: It is used for setting the overall operations and security of the 

Windows 10. 
	 	 • �Network and Internet: It is used to check network status and change settings, set preferences 

for sharing files and computers, configure Internet display and connection, and more. 
	 	 • �Hardware and Sound: It is used to adjust settings of all hardware devices attached to your 

computer like keyboard, printer, mouse, etc. It is also used to control sound settings of the 
computer.

F.	 1. She should enter m??.xlsx in File Explorer search box.
	 2. Manish should go for Extra Large Icons View.

2.
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Worksheet 1
(Based on chapters 1 & 2)

A.	 1. Antivirus is system software used to scan the computer system for presence of viruses. 
	 2. �Disk defragmenter organises the fragments of files into continuous blocks to improve 

performance of the computer.
	 3. Asterisk (*) is used to replace a string of characters in the search term. 
	 4. Tiles view shows the files and folders as medium-sized thumbnails. 
	 5. Content view displays every file/folder in a separate row with its icon and name.

B.	 1.	 Operating 
System

Utility  
Software

Application 
Software

Programming 
Software 

	 2.	 MS  
Windows Mac OS X Linux Calc

	 3.	 MS  
PowerPoint

Adobe 
InDesign

Corel  
Presentations Impress

	 4.	 List Details Wildcard Tiles

C.	 1. �Word Processors: These software are used to create, edit and format text documents. Example: 
Microsoft Word.

	 2. �DBMS: This is used to create, store, modify and organise data stored in a database. Example: 
Microsoft Access.

	 3. �Spreadsheets: These software are used to calculate, compare and analyse data and used to 
prepare different reports. Example: Microsoft Excel.

	 4. �DTP software: These software are designed for creating and producing high-quality printed 
materials and digital publications. Example: Adobe InDesign.

	 5. �Presentation software: These software are used to create presentations which include  
sound, music, video, charts and animation. Example: Microsoft PowerPoint.

	   Introduction to Excel 2019

Exercise
A.	 1. b.	 2. a.	 3. c.	 4. b. 
B.	 1. Spreadsheet	 2. Alphabets	 3. Quick Access Toolbar	 4. Name box

3.
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C.	 1. F	 2. T	 3. F	 4. F
D.	 1. �Ribbon is located at the top of the Excel window and consists of a series of tabs, each containing 

groups of related commands, often represented by icons. 
	 2. �A formula is a mathematical expression used to do simple and complex calculations of the 

numeric data inserted in a cell or a range of cells. A formula always begins with an equal to 
(=) sign e.g. = A2 + B2.

	 3. The range of Column Headings in Excel is from A to XFD.
E.	 1. To enter data in a worksheet, follow these steps:
		  Step 1: Click on the cell where you want to enter the data. 
		  Step 2: Type the data in the cell.
		  Step 3: Repeat Step 1 and 2 until you finish entering all your data.
	 2.	Three components of Excel 2019 window are:
		  •  �Title Bar: It is located on the top of the window that shows the name of the current  

workbook.
		  •  �File Tab: A green button located at the left top corner that contains the file menu commands 

such as New, Open, Save, etc. 
		  •  �Quick Access Toolbar: It is present on the title bar. It displays quick access buttons of the 

Save, Undo and Redo commands. 
	 3.	�There are three different types of data that you can enter in a spreadsheet – Labels, Values 

or Numbers and Formula.
		�  Labels: A label is an important entry in Excel. The label is used to define the information 

on the spreadsheet, i.e., heading of columns, titles and names. It is any text besides phone 
numbers, numbers, formulas, etc. Labels are aligned on the left side of a cell.

F.	 1.	�In Excel, Values/Numbers are always right aligned. Strings are categorised under Labels and 
by default labels are always left aligned in Excel.

	 2.	�Simran should save her workbook for future use. She can go to File Tab and choose Save/
Save As option. 

	   Editing in Excel 2019

Exercise
A.	 1. b.	 2. d.	 3. a.	 4. c.
B.	 1. Autofill		  2. Quick Access	
	 3. Cell formatting		 4. Shift
C.	 1. F	 2. T	 3. F	 4. T

4.
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D.	 1. �There are four ways to select cells in a worksheet. They are: Single Cell, Group of Cells or 
Range, Entire Row/Column, Entire worksheet.

	 2. The Redo command is used to reverse the last Undo command. 

	 3. Click on the column heading to select the entire column. 

E.	 1.	�Excel 2019 provides two ways to modify or change the content of a cell. One is editing the 
content in Edit mode and other is replacing the entire content of the cell directly.

	 2. �When we use the Cut command, the content is moved to the new place and removed from 
its original place. In case of the Copy command, content is duplicated at the new location, 
while the original content remains in its original place. The Paste command is used to paste 
the cut/ copied data into the selected destination.

	 3. �AutoFill feature automatically fills a series of data in your worksheet. It saves your time to 
complete the text or number series for you. 

F.	 1. Kanika should set the column width to 0 to hide it.

	 2. �Manan can use the Merge & Center feature in Excel to combine the physical space of both 
cells A1 and B1 into one larger cell.

	   Formulas and Functions

Exercise

A.	 1. b.	 2. b.	 3. c.	 4. c.	 5. c.

B.	 1. Parenthesis	 2. Range	 3. Arguments	 4. Mixed

C.	 1. F	 2. T	 3. F	 4. F

D.	 1. ORAN

	 2. There are mainly two ways to enter a formula in a worksheet:

		  a. Typing the formula directly in the Cell

		  b. Typing the formula in the Formula bar

	 3. �To obtain the output 46, you should use the ROUNDUP function instead of INT as follows:

	 	 =ROUNDUP(45.789)

E.	 1. The elements of a formula are: 

		  a. References: A cell or a range of cells that you want to use in your calculation.

		  b. Operators: Symbols (+, -, *, /, ^, $, %, etc.) that specify the calculations to be performed.

	 	 c. Constants: Numbers or text values that do not change.

5.
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	 2.  Function Purpose Example

IF(Condition)  
value1, value2)

It checks whether the given 
condition met, and returns 
value1 if the condition evaluates 
to true, and returns value2 if the 
condition evaluates to false.

Percentage = 80
Input: =IF(Percentage >= 50, 
“Passed”, “Failed”)
Output: Passed

	 3. Date and Time Function
		

Functions Purpose Example

TODAY() It returns the current date. Input: =TODAY()
Output: 7/23/2019

MONTH(TODAY) It returns the current month. Input: =MONTH(TODAY())
Output: 7

YEAR(TODAY()) It returns the current year. Input: =YEAR(TODAY())
Output: 2019

F.	 1. Rahul should use Round function. The syntax is ROUND(number, number_of_digits).
	 2. The formula will be = A3+B3.

Worksheet 2
(Based on chapters 3 to 5)

A.	 1. Workbook	 	 2. Cell reference	 	 3. ROUND
	 4. Statistical Function	 5. Autofill	 	 6. MIN
	 7. LEN
B.	 Quick Access Toolbar

Worksheet tab 
scrolling buttons

Name box

Active Cell

Title Bar

Status bar

Control buttons

Mouse Pointer

Formula bar

C.	 Microsoft Excel of MS Office Suite 2019 is the most suitable for this purpose. �
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Test Sheet 1
(Based on chapters 1 to 5)

A.	 1. d. 	 2. d.	 3. d.	 4. a.	 5. c.
B.	 1. Word Processors	 2. Customised Software
	 3. Hardware and Sound	 4. Question mark (?)
	 5. Analyse	 	 6. 10,48,576
	 7. Select All	 	 8. Sheet tab
	 9. equal (=)	 	 10. $ (dollar)
C. 	 1. T	 2. F	 3. F	 4. T	 5. F
	 6. T	 7. F	 8. T	 9. F	 10. T
D.	 1. �Word Processors, Spreadsheet software, and Presentation Graphics software are the examples 

of general purpose software.
	 2. �File Explorer window helps us to organise and manage files and folders. It provides a graphical 

user interface for accessing the file systems.
	 3. There are 16,384 columns in an Excel worksheet.
	 4. �In case of the Copy command, the content is duplicated at the new location, while the original 

content remains in its original place.
	 5. CONCATENATE( ) function joins together two or more different text strings.
E.	 1. �System Software is the most important software to operate a computer. It manages a 

computer’s hardware and basic functions. System software can be classified into three 
categories: Operating System, Programming Software and Utility Software.

	 2. �Wildcard characters helps us to find a file in the computer system even if we don’t know its 
location or complete name. Wildcard is a special character which is used to represent one or 
more characters. Generally, two wildcard characters are commonly used for searching files 
in a system. These are asterisk(*) and question mark (?). 

	 3. To enter data in a worksheet, follow these steps:
		  Step 1: Click on the cell where you want to enter the data. 
		  Step 2: Type the data in the cell.
		  Step 3: Repeat Step 1 and 2 until you finish entering all your data.
	 4. To rename a worksheet tab, follow these steps:
		  Step 1: Right-click on the sheet tab that you want to rename.
		  Step 2: Click on the Rename option to rename the sheet.
		  Step 3: Type in the name you would like for your spreadsheet.
	 5. �Formulas in Excel begin with an equal to (=) sign. When the contents of a cell begin with 

equal to sign, Excel understands that user has given a formula here. If you don’t enter the 
equal to sign, Excel will treat your entry as text and the calculation will fail.
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		�  Whereas, Functions are predefined formulas in Excel to perform both simple and complex 
calculations. They accept arguments and return values. Arguments are input to the functions. 
These arguments can be number or text. The values should be given in between opening 
and closing ( ) parenthesis.

	   Excel as Database

Exercise
A.	 1. a.	 2. b.	 3. c.	 4. c.	 5. d.
B.	 1. Database	 2. Data Validation	 3. Form	 4. Numeric
	 5. Rows, Columns
C.	 1. T	 2. F	 3. F	 4. T	 5. F
D.	 1.	�Excel can arrange the selected data in ascending or descending order. This is called sorting 

of data.
	 2.	�The Pivot Table feature of Excel 2019 allows you to analyse the large amount of data. It 

consolidates, summarises and presents data.
	 3.	A set of values for the fields is called a Record.
E.	 1.	To do custom sort, follow these steps:
		  Step 1: Select the range of columns to be sorted.
		  Step 2: Click on the Sort & Filter command.
		  Step 3: Select Custom Sort option.
		  Step 4: �Check My data has headers checkbox, if the selected columns have a heading at the top.
		  Step 5: Click on the Sort by drop-down list and select the column header.
		  Step 6: Click on the Sort On drop-down list and select Cell Values option.
	 	 Step 7: Click on the Order drop-down list and select the A to Z or Z to A option.
	 	 Step 8: Click on the Add Level button.
	 2.	�The Filter command hides rows that don’t meet specific criteria, making unwanted data 

temporarily invisible. Conditional Formatting highlights specific data using colours or styles 
without hiding any values.

	 3.	The conditional formatting command has following options: 
		  •  �Highlight Cells Rules: This option is selected when you want to highlight all cells satisfying 

a given condition. When you hover mouse over this option, it opens a sub-list showing 
criteria like Greater Than, Less Than, Equal To, Between, etc.

		  •  �Top/Bottom Rules: This option is selected when you want to highlight some top or bottom 
number of items in a data series. When you hover mouse over this option, it opens a  
sub-list showing criteria like Top 10 Items, Top 10%, Bottom 10 Items, Bottom 10%, etc. 

6.
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		  •  �Data Bars: This option is selected when you want to add data bars to the cells having 
numeric data. When you hover mouse over this option, it opens a sub-list showing bars 
of different types and colours that can be added to the cells. 

F.	 1.	Namita should use Data Validation feature to achieve this.
	 2.	Conditional formatting feature can be used to do this.
	 3.	�Niti can filter the student list by first selecting the header row and applying the “Filter” option 

from the “Data” tab. Then, by clicking the filter arrow in the “Name” column, she should 
choose “Text Filters” and select “Begins With,” entering “R” in the dialog box to display only 
students with names starting with that letter.

	   Charts in Excel

Exercise
A.	 1. c.	 2. b.	 3. d.	 4. b.
B.	 1. Category	 2. Scatter	 3. Vertical	 4. Gridlines	 5. Data labels
C.	 1. F	 2. T	 3. T	 4. F	
D.	 1. �A chart is an effective way to display data in a pictorial form. It makes it easier to draw 

comparison and analyse the growth, relationship and trends among the values in a table.
	 2. Pie chart can display only one data series.
	 3. The Chart Tools tab contains two tabs named Design and Format.
E.	 1. The steps to change the design of your chart are:
		  Step 1: Select the chart.
		  Step 2: Click on Design tab and choose Chart Styles group.
		  Step 3: Click on any of the displayed layouts to change the design of your chart.
	 2. The three types of chart are:
		  a. �Line Chart - It is used to show trends over a period of time. It uses connecting dots to 

display trends over a period of time.
		  b. �Column Chart - It is usually used to display the data in the form of vertical bars. It is used 

to show the changes in data over a period of time or comparison among the different data 
items.

		  c. �Pie Chart - It is a circular chart divided into sectors where each sector shows the relative 
size of each value. It always shows only one data series.

	 3.	Legend is a key which shows the meanings of symbols and colours used in the chart.
F.	 1. Kriti should use a Pie Chart to represent the statistical data of her company in a circular format. 
	 2. Advit should use Scatter Chart for analysis.

7.
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Worksheet 3
(Based on chapters 6 & 7)

A.	 1. �Data validation means to restrict the user to enter a specific range of values in a particular 
cell or a range of cells. 

	 2. The Pivot Table feature of Excel 2019 allows you to analyse the large amount of data.
	 3. Area Chart is used to display the quantitative magnitude of the data graphically.
	 4. In-built chart styles are listed under the Insert tab.
	 5. Conditional Formatting command is present under the Home tab.
B. 	 1. �Column chart: It is used to show the changes in data over a period of time or comparison 

among the different data items. 
		  Example: Comparing monthly sales revenue for a company.
	 2. �Pie chart: It is a circular chart divided into sectors where each sector shows the relative size 

of each value. 
		  Example: Percentage distribution of expenses in a family budget.
	 3. �Area chart: It is used to display the quantitative magnitude of the data graphically.
		  Example: Tracking cumulative rainfall over several months.
	 4. Bar chart: It illustrates the comparisons amongst the individual items.
		  Example: Comparison of population across different cities.
	 5. XY Scatter Plot chart: They show the correlations between the two sets of values.
		  Example: Analyzing the relationship between study hours and exam scores.
C. 	� Sanjay can use the Sort feature in Excel to arrange the sales data from maximum to minimum 

(or vice versa) and identify the top and bottom performers.
D. 	 1. c.	 2. d.	 3. b.	 4. e.	 5. a.

	   Charts in Excel

Exercise
A.	 1. d.	 2. d.	 3. b.	 4. c.
B.	 1. Newsgroups	 2. One drive	 3. Wordpress
C.	 1. F	 2. T	 3. F	 4. F
D.	 1.	The most common and popular VoIP services used in India are Skype and Telegram.
	 2.	�Students spend excessive time on social media, diverting attention away from their studies. 

Also, it reduces concentration, leads to mental fatigue, and fosters comparison among peers.
	 3.	�The News Admin keeps a check on the comments of participants, decides when to stop 

discussion as well as approving the comments or articles of participants before they are 
posted on the newsgroup page.

8.
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E.	 1.	E-banking is useful for bankers as well as customers. 
		  The bankers are benefited by way of: 
		  •  Less transaction cost
		  •  Less chances of human error
		  •  Reduction in fixed infrastructure cost
		  •  Customer loyalty and satisfaction 
		  •  Reduced paper work
		  The customers are benefited by way of: 
		  •  Convenience of banking 
		  •  No geographical restrictions
		  •  Lower costs
		  •  Reduced chances of fraud
	 2.	Cloud Storage service has become immensely popular because: 
		  •  �The users need to incur cost of storage devices. They can access storage on remote servers 

by paying a nominal fee only. 
		  •  The users can access their data from anywhere by logging in to their cloud storage account. 
		  •  �The users can also access software and application for limited use which are very expensive 

to purchase.
	 3.	�An e-greeting is just like a paper greeting card. The only difference is that it is created with 

the help of digital text and effects. While paper greeting card is in hard copy, e-greeting is 
in soft copy. 

		�  The animation effects and music along with still images and text makes an e-greeting look 
awesome. Some of the popular e-greetings websites are www.123greetings.com, www.e-
cards.com, etc.

F.	 1.	Mahika should join a Newsgroup related to Sports.
	 2.	Taruna should create a blog to share her travel experiences and suggestions with others.

	   Conditional Statements in Python

Exercise
A.	 1. a.	 2. c.	 3. b.	 4. d.	 5. b.
B.	 1. conditional statements	 2. false	 3. if	 4) :
C.	 1. T	 2. T	 3. F	 4. F	 5. F
D.	 1.	In Python, you check if a condition is true using an if statement.

9.
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	 2.	number = int(input(‘Enter a number: ‘))
		  if number > 0:

		      print(‘The number is greater than 0.’)

	 3.	The syntax of if...elif...else ladder is shown below:
		  Syntax: 

		  if (Test Expressions_1):

		       Indented block 1 

		  elif (Test Expression_2): 

		       Indented block 2 

		  elif (Test Expression_3): 

		          Indented block 3

		  else: 

		           Indented block 4

E.	 1.	�The if…elif…else ladder is another type of if statement. It helps us to test multiple conditions 
and follows a top-down approach. In this, as soon as the condition of the if evaluates to be true, 
the indented block associated with that if is executed, and the rest of the ladder is avoided. 
If none of the conditions evaluates to true, then the final else statement gets executed.

	 2.	age = int(input(‘Enter your age: ‘))
		  if age >= 18:

		      print(‘You are eligible to vote.’)

		  else:

		      print(‘You are not eligible to vote.’)

F.	 1.	�Sonakshi should use an if-else conditional statement to implement this logic in her basic 
login system.

	 2.	�Manik should use an if-elif-else ladder to implement the logic that assigns grades based on 
the marks obtained by his students.

Worksheet 4
(Based on chapters 8 & 9)

A.	 1.	�Blogs: Blogs are generally like a detailed explanation of a subject or sometimes they are also 
used as a Diary of Events.

	 2.	�Cloud Storage: Cloud storage is a service where the users are able to store and manage data 
on remote server in place of their local computer.

	 3.	�Cyber Security: The process of protecting computer resources such as networks, devices, 
programs, and data from unauthorised access, damage, or attack is called cyber security.

	 4.	�Hacking: It is the unauthorised access to computer system for the purpose of destroying the 
system or stealing important information from the system.
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B. 	 1.	age = int(input("Enter your age: "))  
		  if age > 18:

		      print('You are eligible to vote')  

		  else:

		      print('Not eligible to vote')

	 2.	a = 200 
		  b = 33 

		  if b > a:  

		      print("b is greater than a")  

		  else: 

		      print("a is not greater than b")  
C.	 char = input("Enter a character: ").lower()  

	 if char in ('a', 'e', 'i', 'o', 'u'):

	     print("The character is a vowel.")

	 else:

	     print("The character is not a vowel.")

Test Sheet 2
(Based on chapters 6 to 9)

A.	 1. c.	 2. b.	 3. b.
	 4. d.	 5. b.	 6. a.
B. 	 1. Form	 2. Rows, Columns	 	 3. Scatter
	 4. Vertical	 5. OneDrive	 	 6. False
C. 	 1. F	 2. F	 3. T	 4. T
	 5. F	 6. F	 7. T	 8. F
D.	 1. The Pivot Table feature of Excel 2019 allows you to analyse the large amount of data.
	 2. A set of values for the fields is called a Record.
	 3. Pie chart can display only one data series.
	 4. The Chart Tools tab contains two tabs named Design and Format.
	 5. �Students spend excessive time on social media, diverting attention away from their studies. 

Also, it reduces concentration, leads to mental fatigue, and fosters comparison among peers.
	 6. �The News Admin keeps a check on the comments of participants, decides when to stop 

discussion as well as approving the comments or articles of participants before they are 
posted on the newsgroup page.
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	 7.	The syntax of if...elif...else ladder is shown below:
		  Syntax: 
		  if (Test Expressions_1):

		       Indented block 1 

		  elif (Test Expression_2): 

		       Indented block 2 

		  elif (Test Expression_3): 

		          Indented block 3

		   else: 

		           Indented block 4

	 8.	In Python, you check if a condition is true using an if statement.
E.	 1.	To do custom sort, follow these steps:
		  Step 1: Select the range of columns to be sorted.
		  Step 2: Click on the Sort & Filter command.
		  Step 3: Select Custom Sort option.
		  Step 4: �Check My data has headers checkbox, if the selected columns have a heading at the 

top.
		  Step 5: Click on the Sort by drop-down list and select the column header.
		  Step 6: Click on the Sort On drop-down list and select Cell Values option.
	 	 Step 7: Click on the Order drop-down list and select the A to Z or Z to A option.
	 	 Step 8: Click on the Add Level button.
	 2.	The conditional formatting command has following options: 
		  •  �Highlight Cells Rules: This option is selected when you want to highlight all cells satisfying 

a given condition. When you hover mouse over this option, it opens a sub-list showing 
criteria like Greater Than, Less Than, Equal To, Between, etc.

		  •  �Top/Bottom Rules: This option is selected when you want to highlight some top or bottom 
number of items in a data series. When you hover mouse over this option, it opens a sub-
list showing criteria like Top 10 Items, Top 10%, Bottom 10 Items, Bottom 10%, etc. 

		  •  �Data Bars: This option is selected when you want to add data bars to the cells having 
numeric data. When you hover mouse over this option, it opens a sub-list showing bars 
of different types and colours that can be added to the cells.

	 3.	The steps to change the design of your chart are:
		  Step 1: Select the chart.
		  Step 2: Click on Design tab and choose Chart Styles group.
		  Step 3: Click on any of the displayed layouts to change the design of your chart.
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	 4.	E-banking is useful for bankers as well as customers. 
		  The bankers are benefited by way of: 
		  •  �Less transaction cost
		  •  �Less chances of human error
		  •  �Reduction in fixed infrastructure cost
		  •  �Customer loyalty and satisfaction 
		  •  �Reduced paper work
		  The customers are benefited by way of: 
		  •  �Convenience of banking 
		  •  �No geographical restrictions
		  •  �Lower costs
		  •  �Reduced chances of fraud
	 5.	Legend is a key which shows the meanings of symbols and colours used in the chart.
	 6.	�An e-greeting is just like a paper greeting card. The only difference is that it is created with 

the help of digital text and effects. While paper greeting card is in hard copy, e-greeting is 
in soft copy. 

		�  The animation effects and music along with still images and text makes an e-greeting look 
awesome. Some of the popular e-greetings websites are www.123greetings.com, www.e-
cards.com, etc.

	 7.	age = int(input('Enter your age: '))
		  if age >= 18:

		      print('You are eligible to vote.')

		  else:

		      print('You are not eligible to vote.')

	 8.	�The if…elif…else ladder is another type of if statement. It helps us to test multiple conditions 
and follows a top-down approach. In this, as soon as the condition of the if evaluates to be true, 
the indented block associated with that if is executed, and the rest of the ladder is avoided. 
If none of the conditions evaluates to true, then the final else statement gets executed.

 


